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Version Highlights - New Features
 

1. Default times
• System time Parameter values in the editor use this time.

• Release time fade out time for released parameter levels and playback loads.

• Library time Applied library values fade in time.

• Sneak time The fade in or out time for levels operating under the sneak function.

2. Delta
Update cues by pasting the values stored in the delta cue.

3. Effects
• Pre-built effects Color Mix and Rainbow have been added to the pre-built effects.

• Fixture grouping Spread the effect over groups of fixtures.

• Base value The base value is now displayed with the active parameter.

• Include Base The base value stored in an effect library overrides the value in the editor.

4. Fixture mode
When fixtures are patched so there are not overlapping fixture numbers, you can select fixtures without 
specifying the fixture type.

5. Help
For on-line help, tap Help and choose Content, Index, or Search.

6. Home cue
Store fixture specific home values that override home values specified in the device definition.

7. Layout files
• Grid properties Customized grid properties, such as font and color, are now saved in the 

*.cfg (layout) files.

• Format and live mode now Saved in the *.cfg (layout) files.

• Lock windows The lock icon has been added to the basic displays. The lock status is now 
saved in the *.cfg (layout) files. 

8. Libraries and groups
Generate color libraries and groups automatically.

9. Libraries
Improved functionality for bank filters

10. Loading show data
Selectively load the objects, sets, devices, or patch, using the Import item under the File menu.

11. Master/Slave
Improved master and slave switch over

12. Pan and tilt orientation
Access the pan/tilt patch from the Editor toolbar in parameter values mode.



2

Vector
Version Highlights - New Features

13. Parameter Grouping
Parameter grouping can be toggled on or off from the editor toolbar.

14. Playback
• Global go and freeze 

commands
A rate mode for the Editor toolbar. Pause or restore all active chases and 
effects.

• Playback control behavior On/off has been implemented

• Playback wing display Improved playback wing display

• Rate wheels 3 wheels fro global rate control

15. Release 
• Dedicated release time Set a release time in the System Settings dialog box.

• Release fixtures or 
parameters

Release fixtures or parameters from a range of cues.

• Dimmer levels set to zr New behavior in Compulite and tracking modes.

16. REM DIM
Isolate fixtures for identification and editing.

17. Selecting objects
• Active Select active fixtures without specifying the output source

• Dim Set Dim as the default numeric selection. 

18. Store options
• All Params If Active Stores all parameters in the cue if there is no dimmer level.

• All Params for Selected Stores all parameters for the selected fixtures.

• Default in Editor toolbar The store options in the editor toolbar always revert to the default as 
defined in the System Settings dialog box.

19. Views and displays
New and improved displays for:

• DMX ports DMX port display now shows: port number/DMX channel (1 - 512)

• Editor Toolbar Buttons in the default (idle mode) toolbar have been changed.

• Fixtures in TOPO Fixtures in the topo map now show their DMX addresses also.

• Last selection The fixture names that part of the last selection are displayed in yellow in 
the live spot and channel displays.

• LookAhead exam

• Show name and info The show’s name is displayed in the general window title bar. Show file 
information is displayed in the workspace’s show node.

• Tracksheet View how a channel or spot tracks through the cues.
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Summary of Changes
FEATURE DESCRIPTION

Displays An exclamation point sometimes appeared in te status bar for no reason. This does not 
happen anymore.

The master playback cue sheet display did not refresh correctly. Now it does.

Fade times Pressing GOTO 0 did not work. Now it does. 

Pressing GOTO 1.5 generated an error message. This does not happen anymore. 

Ignite spots Sending an ignition (lamp on) command, when 2 types of devices were selected, 
generated an error message. This does not happen anymore. 

Loops and Links When loops and links were combined the playback did not function correctly. This 
has now been corrected. 

Master/Slave Updating cues on the master console caused some temporary cues to disappear on the 
slave console. This does not happen anymore. Thank you to the crew at Lisys and 
House of Tradition, Hungary.

Matrix Incorrect data was displayed when switching views between 2 matrixes. This does not 
happen anymore. Thank you to Gerhard Feiner, Germany.

New Shows The console data was not cleared properly when opening a new show. Now the warm 
data is cleared correctly.

Park For channels, the parked icon was displayed only in the fixture name field and did not 
appear in the fixture number field. Now it appears in the fixture number field also. 

Patch Proportional patch settings were cleared if more than one dimmer was patched to a 
logical channel. This does not happen anymore. 

The proportional patch settings and pan/tilt patched were not saved after shutdown 
even if the show was saved before exiting. Now this information is saved. 

Selecting fixtures An Illegal Set message was generated when selecting a channel on the touch screen (in 
interactive mode) and attempting to select another channel by pressing + and selecting 
a number on the keypad. This does not happen anymore. Thank you to Gerhard 
Feiner. 

Update When updating channels that were output from the master playback and were also 
loaded to a fader whose fader was at zero, the MASTER PLAYBACK ONLY button in 
the Update dialog box was not available. Now it is. Thank you Andy Stone at Stag-
etec, Great Britain. 

Tracking only! When updating values whose source were libraries, the Update Library 
option did not appear in the Update dialog box. Now the libraries appear in the dialog 
box.

VL1000 device The home value, as defined in the Device Builder, for VL1000 rotating gobo rotation 
was incorrect. The home step is now defined as Stop, so the gobo wheel does not 
rotate when idle. Thank you, Gerhard Feiner. 
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Limitations
1. Device Builder. Due to restructuring the manufacturer’s ID, any operator defined devices may not appear 

under the correct manufacturer. To fix: go to the Device Builder and save your device again under the correct 
manufacturer.

2. The key function is not displayed in the key function filed for the A/B crossfader in the A/B view.

3. It is impossible to playback a timed or manual cue out of sequence when loading the cue using the select key.

4. To reset channels to zr, it is necessary to press RESET twice.

5. Snaps, from shows saved on older software versions, do not remember the level of the faders stored in the 
snap.

6. Not all keys stored in the macro are displayed when examining the macro.

7. The contrast and brightness controls for the touch screens are not working yet.

8. It is impossible to set the proportional patch level from the editor toolbar.

9. there is no way to disable the general master’s blackout key (B.O.). This will be implemented in the future.

10. Green Vector only! After power up the general master level is not displayed. Workaround: move it a bit and 
it will be displayed.

11. The sequence EXAM, SELECT does not work yet.

12. The screen refresh command does not work in the TOPO view.

13. In the Topo view, dimmer levels for a device with a 16 bit dimmer does not display in percentage.

14. Cannot scroll down in the cue sheet.

15. Auto save for shows that are 8 megabytes and up may take longer than usual.
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Operating New Features
1.0   Default times

The various default fade times are set in the System Settings dialog box, Timing tab
.

To change default times

1 Open the Tools menu.

2 Tap Settings.

The System Settings dialog box opens.

3 Go to the Timing tab.

4 Enter time values in the default time fields.

5 Tap OK to save and exit.

2.0   Delta
A delta contains absolute and relative modifications of spot parameter levels, channel intensity, and 
scroller frames. Delta is used to edit cues by pasting the levels in the delta to the target cue. The 
levels stored in the delta are grabbed from the editor. The delta feature uses the copy and paste func-
tionality, therefore anything copied to the clipboard overwrites the delta. You can store a new delta 
at any point in programming sequences. Vector supports one delta.

2.1    Delta options

There are three options when pasting the delta:

Relative - the toolbar always defaults to this option.

Absolute

Add new

Figure 1: Editor toolbar in delta mode

System time Speed at which levels fade in or out in the editor.

Release time Speed at which released parameters fade out when released from the editor or 
from a playback device. 

Library time Speed at which library levels fade in or out in the editor

Sneak time Speed at which levels fade in when using the sneak feature.
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2.1.1 Relative

2.1.2 Absolute

2.1.3 Add New

DELTA (as copied when 
editing a cue) TARGET CUE TARGET CUE AFTER 

PASTING DELTA

Channel 1 Absolute: 90
Relative: +30

Channel 1 @ 35 Channel 1 @ 65

Channel 2 Absolute: 90
Relative: +60

Channel 2 @ 50 Channel 2 @ FL

Channel 3 Absolute: 80
Relative: +30

Channel 3 @ 30 Channel 3 @ 60

Channel 4 Absolute: 30
Relative: -40

Channel 4 @ 80 Channel 4 @ 40

DELTA (as copied when 
editing a cue)

TARGET CUE TARGET CUE AFTER 
PASTING DELTA

Channel 1 Absolute: 90
Relative: +30

Channel 1 @ 60 Channel 1 90

Channel 2 Absolute: 90
Relative: +60

Channel 2 @ zr Channel 2 90

Channel 3 Absolute: 80
Relative: +30

Channel 3 @ 30 Channel 3 80

Channel 4 Absolute: 30
Relative: -40

Channel 4 @ 80 Channel 3 30

DELTA (as copied when 
editing a cue)

TARGET CUE TARGET CUE AFTER 
PASTING DELTA

Channel 1 Absolute: 90
Relative: +30

Channel 1 @ 60 Channel 1 @ 60

Channel 2 Absolute: 90
Relative: +60

Channel 2 @ not in cue Channel 2 @ 90

Channel 3 Absolute: 80
Relative: +30

Channel 3 @ 30 Channel 3 @ 30

Channel 4 Absolute: 30
Relative: -40

Channel 4 @ 80 Channel 4 @ 80
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To copy the delta from the editor

1 Select fixtures and adjust levels.

2 Press @.

3 Press COPY.

The absolute and relative values are copied from the editor to the clipboard and are ready 
for pasting.

OR 

1 Select fixtures and adjust levels.

2 Press UPDATE.

The Update dialog box opens.

3 Tap COPY NEW DELTA.

The absolute and relative values are copied from the editor to the clipboard and are ready 
for pasting.

To paste delta values

Example: Update cues 5 through 9 by pasting the levels in the delta.

1 Press CUE, 5, , 9 to select cues 5 through 9.

2 Press @.

3 Press PASTE.

The cues are updated with the new values.

Note:  Using this sequence assumes pasting the relative values in the delta.

OR 

1 Select cues.

2 Tap DELTA.

3 Optional: tap RELATIVE, ABSOLUTE, or ADD NEW.

4 Tap PASTE on the delta toolbar.

The cues are updated with the new values.

3.0   Effects

3.1    Base values
The base value is now displayed next to the active parameter.

3.2    Effect dialog box position

The default position for the effect editor dialog box is aligned left, so the Offset, Size, Rate, and 
Duty attributes appear above their control wheels.

Note:  Vector remembers the dialog box’s last position, therefore if it was moved it will 
not be aligned with the wheels next time it opens.
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3.3    Fan param

The Fan Parameters option fans the effect over parameters. This allows control over the parameters 
in a single spot.

To fan parameters

Example: Apply a fan effect to cyan, magenta, and yellow in spot 1.

1 Select spot 1.

2 Select cyan, magenta, and yellow.

3 Press EFFECT.

The Effect Editor dialog box opens.

4 Select a primitive from the Pre-built, Basic, or Advanced tabs.

5 Go to the Advanced tab.

6 Tap FAN PARAM.

The Offset, Size, and Rate attributes can now be set for fanning parameters.

7 Adjust the Offset, Size, and Rate attributes as required.

3.4    Fixture grouping
Fixture grouping with offset determines how the offset is spread among the devices.
Example: An intensity step effect is running on spots 1 through 10. All 10 spots turn on and off at 
the same time. Set the fixture grouping to 2 and tap WAVE. Now the odd spots are on when the even 
spots are off and vice versa.

3.5    Include Base
Base values in effect libraries override the value in the editor.

3.6    Pre-built effects 

Some effects have been added to the pre-built tab.

Color Mix (Color Mix applies CMY, with an offset, from FL to zr.)

Rainbow

Dimmer Step

Dimmer Fade

Iris In Move

Focus

4.0   Fixture mode
Patching fixture sets so there are no overlapping fixture numbers allows you to select fixtures 
without specifying the fixture type. 
An example of fixtures patched with no overlap is:
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When fixtures are patched with no overlapping fixture numbers, Fixture appears in the command 
line as the default numeric selection. CHANNEL, SPOT, and SET are, of course still active for 
examining fixtures, etc.

To select fixtures in fixture mode

 Just choose the fixture’s number on the keypad.

5.0   Help
To open help

1 Open the Help menu.

2 Tap Context.

The on-line help file opens. Browse according to topic, index entries, or search.

Note:  There are two books available in the help file: Action syntax and Enter 
(Broadway style) syntax. Choose the help for the syntax that you are using.

6.0   Home Cue
Occasionally a parameter’s home level, as set in the device definition, is not compatible with some 
fixtures because of, for example, their hanging positions. You can store a fixture specific home cue, 
which overrides home levels set in the device definition. Values for fixtures not included in the 
home cue go the values set in the device definition.

 To program the home cue

1 Select the fixtures.

2 Select the parameters and set the parameter levels.

3 Press CUE.

4 Press HOME.

5 Press STORE.

 To delete the home cue

1 Press CUE.

2 Press HOME.

3 Press DELETE.

4 Tap DELETE again.

FIXTURE SET FIXTURE NUMBERS

Channel 1 to 100

Spot 201 to 300

Matrix 401 to 512.
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7.0   Layouts

7.1    Grid properties

Grid properties that you have customized in the Grid Properties dialog box > Grid tab are now saved 
with your layouts.

To customize grid properties

Example: Customize the grid look for the master playback pane.

1 Point at one of the headings in the master playback pane and right click.

2 Choose Properties from the fly out menu.

The Grid Properties dialog box opens.

3 Go to the Grid tab.

4 Tap Customize to enable the fields.

5 Set the fields.

6 Tap OK to save and exit.

These settings will be saved with your layout.

To return to default grid properties

1 Point at one of the headings in the master playback pane and right click.

2 Choose Properties from the fly out menu.

The Grid Properties dialog box opens.

3 Go to the Grid tab.

4 Tap Customize to disable.

All fields return to their factory default settings.

5 Tap OK to save and exit.

7.2    Formats and fixtures displayed

All display customization done through the Format menu or the Live Mode menu are now saved 
with layouts.

8.0   Libraries and groups - automatic generation
Through the Generate Libraries and Groups dialog box, Vector automatically generates:

Color libraries

You can customize the look for: specific display panes:

COLUMNS ROWS GRID LINES

• Font • Font • Row line weight

• Font (foreground) color • Font (foreground) color • Column line weight

• Background (field) color • Line color
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Intensity libraries

Image libraries

Groups

You can choose to generate some or all of these objects for some or all of the devices used in the 
show.

Figure 2: Generate libraries and groups dialog box

You can number the libraries and groups to your convenience in the dialog box’s numbering area. 
The numbering option fields are:

If there are existing libraries and groups you can choose to:

Leave them as is

Overwrite them

Update them

To open the Generate Groups and Libs dialog box

 Open the Tools menu and tap Generate Groups and Libs.

OR 

1 Press SET.

2 Tap the GENERATE GROUPS AND LIBRARIES button on the Editor toolbar.

Start From Store the first generated library or group to the number in this field and sequen-
tially increment the libraries or groups. 

Align Choose an offset. Generally, it is convenient to chose an offset that corresponds 
to your display set up.
Example: Assume that you have sized the soft keys pane to show 5 soft keys per 
row. You choose to generate 5 groups for each fixture type. If the start number is 
1 and the offset is 10, the generated groups will appear in every other row.



12

Vector

8.1    Generating libraries

Color and image libraries can be generated for one device or for multiple devices. When generating 
these libraries for multiple devices, you must select a primary device. Vector generates the libraries 
for multiple devices according to the primary device. Example: You want to generate color libraries 
that will be common to three devices. The primary device has a color wheel and the other 2 devices 
lack a color wheel, but have CMY color parameters. The libraries are generated according to the 
primary device’s color wheel. For the other devices, Vector sets their CMY levels to match the 
primary device’s color wheel.

You can also chose to generate separate libraries for each device.

IMPORTANT!  To generate libraries the check box next to the library type must be 
checked and the library type must be selected. When selected the library type (or group) 
appears on a light field.

To generate common color or image libraries for multiple devices

1 Open the Tool menu.

2 Choose (tap) Generate Groups and Libs.

The Generate Groups and Libs dialog box opens.

3 Expand Generate All.

4 Make sure Color or Image are checked.

5 Tap Color or Image to select.

The item appears on a light field.

6 Set the start number and the interval.

7 Select the primary device from the drop down dialog menu.

8 Make sure the devices are checked under the Generate for Devices list.

9 Select the behavior (Leave, Overwrite. or Update).

10 Tap APPLY or OK.

The libraries are generated according to the primary device.

To generate separate color or image libraries 

1 Open the Tool menu.

2 Choose (tap) Generate Groups and Libs 

The Generate Groups and Libs dialog box opens.

3 Expand Generate All.

4 Make sure Color or Image are checked.

5 Tap Color or Image to select.

The item appears on a light field.

6 Make sure the devices are checked under the Generate for Devices list.

7 Set the start number and the interval.
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8 Tap SEPARATE LIBRARIES.

9 Select the behavior (Leave, Overwrite. or Update).

10 Tap APPLY or OK.

Libraries are generated for each device.

To generate intensity libraries

1 Open the Tool menu.

2 Choose (tap) Generate Groups and Libs.

The dialog box opens.

3 Expand Generate All.

4 Make sure Intensity is checked.

5 Make sure the devices are checked under the Generate for Devices list.

6 Set the start number and the interval.

7 Set the level increments in the% Step field.

8 Select the behavior (Leave, Overwrite. or Update).

9 Tap APPLY.

8.2    Generating groups

The automatic fixture group options for spots per device, channels, and scrollers are:

All

Even

Odd

Every third - counting from the first fixture of a device type.

Every fourth - counting from the first fixture of a device type.

To generate groups

1 Open the Tool menu.

2 Choose (tap) Generate Groups and Libs.

The dialog box opens.

3 Expand Generate All.

4 Make sure Groups is checked.

5 Expand Generate for Devices and make sure the devices you want organized into groups 
are checked.

6 Set the start number and the interval.

7 Select the type of group (Even, Odd, All, 3rd, 4th).

8 Select the behavior (Leave, Overwrite. or Update).

9 Tap APPLY.
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9.0   Libraries
The functionality of the bank filters has been improved.

In some cases, you might want to store parameters in libraries that do not normally accept such 
parameters. For instance, you might want to store pan and tilt in a color library, which normally 
allows only parameters belonging to the color parameter type. When BANK FILTER is off, any 
parameter can be stored in a library. 

The default is BANK FILTER on and the button has an orange field.

To store an unfiltered library

Example: Store all parameters active in the editor in a color library.

1 Select the fixtures.

2 Set a dimmer level.

3 Adjust the pan and tilt.

4 Set color levels.

5 Press LIB.

6 Press COLOR.

7 Tap BANK FILTERS.

The button now has a blue background and library filtering according to parameter type is 
cancelled.

8 Store to a color library.

The color library contains dimmer, pan, and tilt, as well as the color parameters.

To store some active parameters in a library

Example: Pan, tilt, dimmer, and color parameters are active in the editor. You want to store 
pan, tilt, and color settings in a color library, but not the dimmer.

1 Select the fixtures.

2 Set a dimmer level.

3 Adjust the pan and tilt.

4 Set color levels.

5 Press POSITION.

The position wheel bank is now available.

6 Press the parameter keys to select pan and tilt.

Pan and tilt are now selected (they appear in red) in the editor.

7 Press LIB.

8 Press COLOR.

9 Tap BANK FILTERS.

The button now has a blue background and library filtering according to parameter type is 
cancelled.
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10 Store to a color library.

The color library contains pan, tilt, and the color parameters.

10.0   Loading specific objects and patch information
You can load selected objects or patch information from shows to Vector. This is useful, for 
example, if you want to reuse the patch or libraries from a previous show.

The objects you can load are:

QLists - all or specific QLists

Libraries - all or specific libraries

Groups

Snaps

Macros

The patch information that can be loaded includes:

Devices

Sets

DMX address patch

Numbering imported objects is customizable. The Numbering Options group in the Import dialog 
box allows you to:

To load specific objects

1 Open the File menu.

2 Choose (tap) Import.

The Open dialog box opens.

3 Select the show and open.

4 Tap the object you want to load.

5 Select the numbering option.

Example: Your current show has QLists numbered from 1 to 5. You are importing QLists 4 
through 6 from a previous show.

Append Start numbering imported objects from the next available number. As per the 
example: The imported QList 4 becomes QList 6, imported QList 5 becomes 
QList 7, and imposed QList 6 becomes QList 8.

Start From Specify the start number for the imported objects. As per the example: 
Starting from 10, imported QList 4 becomes QList 10, imported QList 5 
becomes QList 11, and imported QList 6 becomes QList 12.

Keep Original The original object numbers are preserved. If there are objects in the current 
show with the same number, the imported object will not be loaded. As per the 
example: Only QList 6 will be imported.

Overwrite The imported objects will overwrite the existing objects. As per the example: 
imported QLists 4 and 5 overwrite the current QLists 4 and 5.
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6 If required, tap SELECT or DESELECT in the Select Range group, and select the range of 
cues or libraries, etc.

7 Tap OK.

11.0   Master/Slave
There have been some improvements in the master/slave function.

1. Editor levels are transmitted to the slave console.
2. There is improved runtime and windows synchronization between the master console and the 

slave console.

3. The rules governing master/slave switchover in the case of master console failure are:

 a. If the master fails, the slave takes over in 100 milliseconds.

 b. When the master is restarted, it is automatically set as the slave console. All data from the 
current master console (formerly the slave console) is loaded to the new slave console.

 c. If the connection to the master is restored in less than 10 seconds after failure, it is re-estab-
lished as the master console.

12.0   Pan and tilt orientation
A PAN/TILT PATCH button has been added to the Editor toolbar in selection mode. Tapping this 
button switches the Editor toolbar to pan/tilt mode.

Use the buttons in this mode to logically orient the pan and tilt directions to trackball movement. 
The buttons are:

INVERT PAN - Switch the full and zero values for pan.

INVERT TILT - Switch the full and zero values for tilt.

SWAP PAN/TILT - Pan becomes tilt and tilt becomes pan.

13.0   Parameter Grouping
When editing parameter levels, parameter grouping selects all parameters grouped together under 
the same parameter type. If, for example, you are setting levels for pan all parameters defined as 
part of the position parameter type are selected in the editor. Therefore, all parameters belonging to 
the parameter type will be stored in the new library or cue regardless if they have been assigned 
values or not.

By disabling parameter grouping, you can isolate a parameter from the other parameters belonging 
to the same parameter type. This allows you to filter libraries by storing only the selected param-
eter(s) in the library. Example: The color parameter type includes cyan, magenta, yellow, color 
wheel 1, and color wheel 2. To store a library that includes only color wheel 1, you set parameter 
grouping to off. 

The parameter grouping default (enabled or disabled) is set in the System Settings dialog box. 
Parameter grouping can be toggled on or off from the Editor toolbar.

The PARAMETER GROUPING button is available on the Editor tool bar in fixture selection mode. 
PARAMETER GROUPING always resets to the setting in the System Settings dialog box.
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To isolate parameters

Example: Parameter grouping is enabled in the System Settings dialog box. You want to store 
a beam library that will contain only the iris levels.

1 Select the spots.

2 Tap PARAMETER GROUPING on the Editor toolbar.

The command line displays: Parameter Grouping Off.

3 Set the levels for the iris.

Only the iris is active in the editor.

4 Store a library using the usual procedure.

The library contains the iris parameter only.

The parameter grouping setting defaults to on.

14.0   Playback

14.1    Global go and freeze commands for chases and effects

Put all the playback devices under global control to freeze or restore effects and chases.

Pressing RATE, switches the Editor toolbar to rate mode. The buttons in rate mode are:

RESET RATE - 

FREEZE ALL - toggles freezing and running all active chases and effects.

FREEZE CHASE - toggles freezing and running all active chases.

FREEZE EFFECT - toggles freezing and running all active effects.

14.2    Playback wing display
The fader level and fader priority are displayed together.

When a fader is at its bottom stop, the fader level is displayed as zr.

The indications symbols are displayed next to the PB page and number.

14.3    Using wheels for rate control

You can control the rate for one or more than one playback device. Also, all playback devices can 
be globally put under rate control.

 To use global rate control (control all faders)

 Press RATE; The Editor toolbar is now in rate mode and the wheels also control rates. The 
wheels and the toolbar buttons affect all playback devices.

 To exit global rate control

 Press SHIFT + RATE. Playback device rates are reset.

 To put a specific playback device under rate control

1 Press RATE (the large key next to BEAT).

2 Press SELECT for the specific playback device.
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Note:  To bring additional playback devices under rate control, press their 
SELECT keys.

3 Use the CHASE RATE wheel to control the fade rate for the selected chaser or use the 
toolbar buttons.

14.4    On/Off playback device definition

You can define a playback device control key as an On/Off key. On initiates a Go command; Off 
releases the playback device’s output. This is especially useful with QKeys where there is only one 
control key available.

On/Off is a toggle. One press initiates the go command. The second press releases the output.

 To define an On/Off key

Example: Define the control key for Qkey 10 for On/Off.

1 Press SETUP.

2 Press the SELECT key for a Qkey 10. The Playback Properties dialog box opens. 

3 Tap the Playback Definitions tab.

4 Click on the control key. 

The fly-out list shows the options.

5 Tap On/Off.

6 Tap CLOSE to exit the dialog box and save playback device settings.

15.0   Release

15.1    Setting default release time

In the System Settings dialog box > Timing tab, you can set a default release time. This release time 
is used for parameters fading out after pressing reset and for fixtures and parameters released from 
cues.

15.2    Releasing fixtures or parameters from cues

You can release fixtures or parameters from a range of cues.

To release fixtures from a range of cues

1 Select the cues.

2 Select the fixture(s).

3 Press RELEASE.

4 Press STORE.

The selected fixtures are released from the range of cues and the cues are stored.

To release parameters from a range of cues

Example: Release the cyan and magenta from cues 1 thorough 6.

1 If necessary, select the QList.
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2 Select cues 1 thorough 6: CUE 1  6.

3 Select the fixture(s).

4 Press COLOR.

The color wheel bank is now available.

5 Tap CYAN and MAGENTA.

6 Press RELEASE.

7 Press STORE.

The selected parameters are released from the range of cues and the cues are stored.

15.3    Releasing fixtures from cues when the dimmer level is zr

Compulite mode! When a fixture’s dimmer level is set to zr, it is released from the editor and not 
stored. 

Tracking mode! When a fixture’s dimmer level is set to zr, this is stored in the cue. If the dimmer 
level remains unchanged in the next cue, no longer appears. The level zr does not track.

Example: In Cue 1, channel 1 intensity is at 75, in Cue 2, channel 1 intensity is set at zr and it saved 
in the cue, in Cue 3 there is no change to channels 1’s intensity therefore is no longer tracked and 
does not appear in cue 3.

16.0   Rem Dim
Another way to isolate a fixture for easy identification, is by using rem dim. This feature keeps the 
selected fixture or fixtures at stage values, while forcing all other fixtures to zero. REM DIM works 
on all output from the editor and from playback devices.

Since this is an editor function, all parameters and wheels are available for fixture editing while 
REM DIM is active. You can also apply a library to the REM DIM selection. You can store new cues 
while the Rem Dim function is active. All zero intensity values (zr) are stored in the new cue.

Exiting Rem Dim releases all unchanged values to playback device control. Parameter and dimmer 
values that were modified while REM DIM was active are retained in the editor.

 To blackout all fixtures except the selected fixture

1 Select the fixture(s).

2 Tap REM DIM on the Editor toolbar. 

Only the selected fixture’s dimmer remains on. All other fixtures are entered to the editor 
and forced to zr.

3 Edit and store as a cue.

 Or

Tap REM DIM to exit.

 To locate a fixture 

1 Select a starting fixture.
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2 Tap REM DIM on the Editor toolbar. 

Only the selected fixture’s dimmer remains on. All other fixtures are entered to the editor 
and forced to zr.

3 Press NEXT or PREVIOUS to advance. 

The active fixture’s stage level is restored.

4 Tap REM DIM to exit and return the dimmer levels to all fixtures.

Note:  NEXT and PREVIOUS cannot be used if a range of fixtures has been selected.

17.0   Selecting objects

17.1    Selecting fixtures using ACTIVE

You can make selections without specifying a source. The fixtures selected depends on the 
console’s current state. If the last selection is still active on the wheel, all fixtures in the last selec-
tion will be selected. If not all output will be selected.

 To select without specifying a source

 Press SHIFT + ACTIVE.

17.2    Dim as the command line default selection

When dim is the command line default selection, Dim appears at the head of the command line. any 
numeric selection is recognized by Vector as a dimmer selection, without having to press dim 
before choosing the number.

To set Dim as the default

 Press DIM twice. Dim appears in the command line. Vector now recognizes the first number 
selection as dimmer selection, making it unnecessary to press this key before the number 
selection.

18.0   Store options
Default store options are set in the System Settings dialog box. The default settings can be over-
ridden on the fly while programming your show.

18.1    All Params If Active
ALL PARAMS IF ACTIVE stores all parameters output from the editor to a new cue if the dimmer is 
active in the editor.

Note:  If the dimmer level is set at zr, this is also considered as active parameter output.

To store a cue using All Params if Active

Scenario: The cue that is currently output contains spots 1 through 6. The editor contains spots 
1 through 12. You want to merge the editor output and the cue output and store as the next cue. 
Use the ALL PARAMS IF ACTIVE option.

1 Select the spots.

2 Set levels for parameters.
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3 Tap STORE OPTIONS on the Editor toolbar.

4 Tap ALL PARAMS IF ACTIVE

5 Press STORE+.

Fixtures in the editor output and the playback output are stored to the next available cue 
number.

18.2    All Params for Selected
ALL PARAMS IF SELECTED stores all parameters for the selected fixtures, even if the parameters 
are not active in the editor and even if there is no dimmer level set.

To store active and inactive parameters in a cue

Example: Spots 1 through 6 are selected. There are active parameter levels for pan, tilt, cyan, 
and magenta. Using ALL PARAMS IF SELECTED stores the active parameters and all other 
parameters (such as color wheel, gobo wheel, iris, etc) in the cue.

1 Select the spots.

2 Set levels for pan and tilt.

3 Press COLOR and set levels for cyan and magenta.

4 Press CUE and choose a cue number.

5 Tap STORE OPTIONS on the Editor toolbar.

6 Tap ALL PARAMS IF SELECTED

7 Press STORE.

All parameters are stored in the cue.

18.3    Default store options in the Editor toolbar
The store options in the editor toolbar always revert to the default as defined in the System Settings 
dialog box.
STORE OPTIONS is available on the Editor toolbar in select mode, parameter (levels) mode, and 
cue mode.

19.0   Views

19.1    DMX ports
DMX port display now shows: port number/DMX channel (1 - 512). Example: DMX universe 3, 
channel 124 is displayed as 3/124.

19.2    Editor Toolbar
Buttons appearing in the default (idle mode) toolbar have been changed. 

Note:  These buttons are available when the editor is idle and you are using Enter syntax.

.

BUTTON FUNCTION

EDIT CUE Go to the selected cue on a playback device and enter the levels to the 
editor. Include only the fixtures and levels stored in the cue.
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19.3    Last selection

If the last fixture selection is still active, the fixtures are shown in yellow on the live spot and 
channel displays.

Note:  The last selection is always active unless the editor has been completely reset by 
pressing SHIFT + RESET.

19.4    LookAhead exam
You can examine the LookAhead mask.

To examine the LookAhead mask

1 Open the Workspace.

2 Expand the Show node.

3 Tap LookAhead Mask.

A list of spots in the LookAhead mask are displayed in the exam pane.

19.5    Topo

In the patch manager and in hard copy, the fixtures’ DMX addresses are displayed in a box under 
each fixture.

19.6    Viewing a QList track sheet

QList track sheets show the cues, the fixtures used in the cues, and the parameter levels in each 
QList. You can view channels’ dimmer levels or spots’ parameter levels. You select what is 
displayed, by choosing the fixture type and parameter in the controls located in the view pane’s 
header.

Figure 3: Track sheet controls in the pane header

IMPORTANT!  To switch from viewing channels to viewing spot parameters, the view 
pane’s header must be visible.

LOAD CUE Open the selected cue in the editor. Include only the fixtures and levels 
stored in the cue.

LOAD STATE Open the selected cue in the editor. Include the fixtures and levels stored 
in the cue and all fixtures and levels that are tracking.

LIBRARY Set Vector for library selection. 
Note: This button is available when using Enter or Action syntax.

EDIT LIBRARY Open the selected library for editing.

BUTTON FUNCTION

parameter selection
fixture selection

number of columns displayed
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 To view a QList track sheet

1 Select a QList.

2 Press EXAM.

3 Tap the side tab labelled TSheet.

A list of cues, the fixtures in each cue, and the cues where the selected fixture is active is 
displayed.

4 To view channels, choose channels in the combo box list in the pane header. To view spots, 
select spots in the combo box list in the pane header. Select the parameter that you want to 
view in the combo box list in the pane header.


